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Introduction

OS X Mountain Lion is the latest version of 
the computer operating system that put the 
phrase graphic user interface in every-
one’s vocabulary. With OS X, you can point, 
click, and drag to work with files, appli-
cations, and utilities. Because the same 
intuitive interface is utilized throughout the 
system, you’ll find that a procedure that 
works in one program works in virtually all 
the others.

Using This Book
This Visual QuickStart Guide will help you 
learn OS X Mountain Lion by providing 
step-by-step instructions, plenty of illus-
trations, and a generous helping of tips. 
On these pages, you’ll find everything 
you need to know to get up and running 
quickly with OS X—and a lot more!

This book was designed for page flip-
ping. Use the table of contents or index 
to find the topics you need help for, learn 
what you need to know, and get on with 
your work. If you’re brand new to OS X, 
however, I recommend that you begin by 
reading at least Part I of this book. In those 
chapters, you’ll find basic information 

about techniques you’ll use every day with 
your computer.

If you’re interested in information about 
new OS X features, be sure to browse 
through this Introduction. It’ll give you a 
good idea of what you can expect to see 
on your computer.

But Wait, There’s More!
Although this book is almost 650 pages 
long, it doesn’t cover every single aspect 
of using OS X. You can find additional 
material that didn’t make it into this book—
including content about features that were 
just being announced when this book went 
to press—on my book support website, 
www.MariasGuides.com.

Visual QuickStart Guides are now even 
more visual: Building on the success of the 
top-selling Visual QuickStart Guide books, 
Peachpit now offers Video QuickStarts. As 
a companion to this book, Peachpit offers 
more than an hour of short, task-based 
videos that will help you master Mountain 
Lion’s top features and techniques; instead 
of just reading about how to use a tool, 

http://www.MariasGuides.com
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you can watch it in action. It’s a great way 
to learn all the basics and some of the 
newer or more complex features of the 
program. Log on to the Peachpit site at 
www.peachpit.com/register to register 
your book, and you’ll find a free streaming 
sample; purchasing the rest of the material 
is quick and easy.

New Features in OS X 
Mountain Lion
OS X Mountain Lion includes several 
brand new features, as well as a handful of 
interface and functionality improvements 
and “under-the-hood” changes to improve 
performance. 

Here’s a look at some of the new and 
revised features you can expect to find in 
OS X Mountain Lion; most of these fea-
tures are covered in detail throughout the 
pages of this book.

 You can learn more about the new fea-
tures of OS X Mountain Lion on Apple’s Web 
site at www.apple.com/osx/.

Brand New Features
n	 Notification Center A offers a customiz-

able interface for receiving notifications 
from a wide range of applications.

n	 A new Share button B enables you to 
share items with a variety of appropri-
ate services and apps, including Twitter, 
Flickr, AirDrop, and Mail.

n	 Dictation makes it possible to dictate 
text anywhere it can be typed in.

n	 Messages C combines the features 
of the old iChat app with the ability to 
send and receive text messages to 
other Macs and iOS devices.

A Notification 
Center can display 
a wide range of 
notification types in 
a variety of ways.

B Click the new Share button to 
access a menu full of sharing options 
that vary depending on the item 
you’re working with.

C Messages combines text messaging with chat 
features into one interface.

http://www.peachpit.com/register
http://www.apple.com/osx/
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n	 The new Reminders app D makes 
it possible to track to-do items with 
reminders based on dates, times, and 
locations—and sync them via iCloud 
with other Macs and iOS devices on 
your Apple ID.

n	 The new Notes app E offers a simple 
but effective interface for keeping 
freeform notes—and syncing them via 
iCloud with other Macs and iOS devices 
on your Apple ID.

n	 The new Game Center app F enables 
you to personalize your gaming experi-
ence by adding friends and tracking 
your performance on a leaderboard.

n	 iCloud enables you to store documents 
and data in “the cloud,” making it easy 
to synchronize them between comput-
ers and devices.

n	 Gatekeeper enables you to limit the 
sources of applications you install to 
help prevent the installation of malware.

n	 OS X now supports AirPlay Mirroring, 
so you can wirelessly display what’s on 
your Mac to Apple TV.

n	 Twitter and Facebook integration make 
it possible for you to set up your Twit-
ter and Facebook accounts once and 
access them from almost any window 
or app.

E Notes offers a simple interface for entering and 
saving freeform notes.

D Reminders lets you create to-do lists 
full of tasks.

F Game Center makes it easy to find and 
compete with friends.
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System & Finder Improvements
n	 Finder copying now displays progress 

bar for each file being copied, right on 
the icon.

n	 Auto Save has been improved to be 
more intuitive, offer title bar document 
renaming, and support iCloud for saving 
documents.

n	 Launchpad can now be searched G to 
find applications quickly.

n	 Screen Saver H includes new slide 
show options that include a Photo 
Stream module.

n	 Software Update has been integrated 
into the Mac App Store so you can 
update all your Apple software and App 
Store purchases from one screen.

n	 OS X now checks for security updates 
every day to keep your Mac secure.

n	 Power Nap enables your computer to 
download and install important updates 
and perform Time Capsule backups 
while your Mac sleeps.

G You can now search for apps within LaunchPad.

H Screen Saver has been completely revised to 
include more photo screen saver modules.
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Other Improved Features
n	 Calendar (formerly iCal) now displays a 

list of all your calendars in a convenient 
sidebar. A new date picker I makes it 
easier than ever to enter dates.

n	 Contacts (formerly Address Book) 
has an improved interface that uni-
fies groups J and contacts onto one 
screen.

n	 Mail now lets you tag certain people 
as VIPs and organizes messages from 
them into a VIPs smart folder.

n	 Safari’s address bar and search box are 
now combined into one field K that 
you can use to search for Web content 
or go right to a URL.

n	 TextEdit now supports a pinching ges-
ture to zoom.

n	 Dashboard has a new widget browser 
to make it easier to find widgets when 
you need them.

n	 The Dictionary app now supports swip-
ing between pages and includes new 
dictionaries for Chinese, Spanish, and 
German.

n	 Time Machine supports multiple backup 
locations.

n	 The Accessibility preferences pane has 
been improved to add more features 
and make it easier to customize them.

I Calendar’s 
new date picker 
makes it easy to 
enter a date.

J In Calendar, you can now display 
groups in a column on the left side of 
the window.

K You can now use the address bar for entering 
URLs or search phrases.
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The OS X Finder displays the contents of 
your hard disk and other accessible vol-
umes in windows. A window can show the 
contents of a volume or folder.

OS X offers several different window views 
that make it easy to see and work with a 
window’s contents. For example, you can 
view contents as icons or hierarchical lists 
that can be sorted any way you like. You 
can even use views that include previews 
of document contents so you can see a 
document without even opening it.

In this chapter, I tell you more about how 
to work with OS X’s window views. By 
understanding how each view works and 
what features it offers, you should be able 
to decide which views work best for the 
things you need to do.

4
Window Views

In This Chapter
Window Views	 52

Working with Icon View	 54

Working with List View	 55

Working with Column View	 59

Working with Cover Flow	 61

Arranging Window Contents	 63
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Window Views
A Finder window’s contents can be dis-
played using four different views:

n	 Icon displays the window’s contents as 
icons A. You can set the icon size and 
rearrange icons within the window.

n	 List displays the window’s contents as a 
sorted list B. You can use disclosure tri-
angles to hide or show folder contents.

n	 Columns displays the window’s con-
tents with a multiple-column format that 
shows the currently selected disk or 
folder and the items within it C. The 
right-most column displays a preview of 
a selected item.

n	 Cover Flow displays a folder’s contents 
as preview images at the top of the 
window D. If you have a Multi-Touch 
device, you can use gestures to scroll 
through the preview icons.

You can switch from one view to another 
with the click of a button, making it easy 
to use any view you like for any window 
you’re viewing. You can also set the view 
for each window separately.

ABCD OS X’s four window views: icons view, 
list view, column view, and Cover Flow view.
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To set a window’s view:
1.	 If necessary, activate the window for 

which you want to change the view.

2.	 Do one of the following:

>	 Choose the view option you want 
from the View menu E, or press the 
corresponding shortcut key: 
Icon view: Command-1 
List view: Command-2 
Column view: Command-3 
Cover Flow view: Command-4

>	 Click the toolbar’s view button for 
the view you want F. The button will 
appear “pushed in” when selected.

>	 Right-click in the window to display 
a contextual menu and choose the 
view you want from the View sub-
menu G.

The view of the window changes.

 Commands on the View menu E work 
on the active window only.

 A check mark appears on the View menu 
beside the name of the view applied to the 
active window E.

 If the toolbar is not showing for a window, 
you can choose View > Show Toolbar or press 
Option-Command-T to display it.

E You can choose 
an option from the 
top of the View 
menu to change 
the active window’s 
view.

Icons view

List view Cover Flow view

Columns view

F Use the View buttons on the toolbar 
to switch from one view to another.

G Right-clicking in a window displays a contextual 
menu you can use to change the view. This is 
particularly handy when the toolbar is not showing.
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Working with 
Icon View
Icon view displays a window’s contents as 
icons. Unlike some other views, a window 
in icon view displays the contents of only 
one disk or folder at a time.

As discussed on page 20, icons can be 
dragged to reposition them in a window. 
You can also use commands under the 
View menu to align icons in the window.

 Chapter 2 explains the basics of working 
with icons in the Finder.

To clean up a window:
1.	 Activate the window that you want to 

clean up A.

2.	 Choose View > Clean Up B. 

The icons are moved into the near-
est unoccupied space in the window’s 
invisible grid C.

 A window’s invisible grid (page 477) 
ensures consistent spacing between icons.

 You can manually position an icon in the 
window’s invisible grid by holding down the 
Command key while dragging it within the 
window.

 If one or more icons in the window are 
selected when you display the View menu, 
the Clean Up command appears as Clean Up 
Selection. You can use this command to repo-
sition just the selected icons in a window.

 You can use the Clean Up By submenu 
under the View menu D to neaten up a win-
dow and place icons in a specific order at the 
same time.

A Sometimes windows just get messy.

C …to move icons into the window’s invisible grid.

B You can choose 
the Clean Up 
command under the 
View menu…

D The Clean Up 
By submenu under 
the View menu.
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Working with List View
List view displays a window’s contents in 
an ordered list. Items cannot be manually 
moved around so there’s no need for a 
Clean Up command.

Windows displayed in list view also have 
a feature not found in other views: They 
can display the contents of folders within 
the window as an outline. This makes it 
possible to see and select the contents of 
more than one folder at a time.

To sort a window’s contents:
Click the column heading for the column 
you want to sort by. 

The list is sorted by that column A.

 You can identify the column by which a 
list is sorted by its colored column heading A.

 You can reverse a window’s sort order by 
clicking the sort column’s heading a second 
time B.

 You can determine the sort direction by 
looking at the arrow in the sort column. When 
it points up, the items are sorted in ascending 
order B; when it points down, the items are 
sorted in descending order A.

 To properly sort by size, you must turn on 
the Calculate all Sizes option for the window 
(page 480).

 You can specify which columns should 
appear in a window by setting view options 
(page 480).

Sort Column

A Click a column heading to sort by that column.

B Click the same column heading to reverse that 
column’s sort order.
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To display or hide a folder’s 
contents in outline list view:
n	 To display a folder’s contents, use one 

of the following techniques:

>	 Click the right-pointing disclosure 
triangle beside the folder C.

>	 Click the folder once to select it, and 
press Command-Right Arrow.

The items within that folder are listed 
below it, slightly indented D.

n	 To hide a folder’s contents, use one of 
the following techniques:

>	 Click the down-pointing disclosure 
triangle beside the folder E.

>	 Click the folder once to select it, and 
press Command-Left Arrow.

The outline collapses to hide the items 
in the folder D.

 You can use this technique to display mul-
tiple levels of folders in the same window E.

Disclosure triangles

C Disclosure triangles that point to the right 
indicate hidden content.

Disclosure triangle

D A disclosure triangle that points down indicates 
displayed content. In list view, this displays folder 
contents as an outline.

E In list view, you can display multiple levels of 
folders as an outline.
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To select multiple contiguous 
icons in list view:
Use one of the following techniques:

n	 Position the pointer in front of the first 
icon and drag over the other icons you 
want to select F.

n	 Click to select the first icon G, hold 
down the Shift key, and click the last 
icon in the group you want to select H.

To select multiple noncontiguous 
icons in list view:
1.	 Click to select an icon G.

2.	 Hold down the Command key and click 
another icon.

The icon is also selected I.

3.	 Repeat step 2 until all icons have been 
selected.

To deselect icons:
Click anywhere in the window other than 
on an icon’s line of information.

F Drag over the other icons you want to select.

G Select the first icon.

H Hold down Shift and click the last icon.

I Command-click additional icons to select them.



58  Chapter 4

To change a column’s width:
1.	 Position the pointer on the line between 

the heading for the column whose 
width you want to change and the col-
umn to its right.

The pointer  turns into a vertical bar 
with two arrows J.

2.	 Press the button down and drag:

>	 To make the column narrower, drag to 
the left K.

>	 To make the column wider, drag to 
the right.

3.	 When the column is displayed at the 
desired width, release the button.

 If you make a column too narrow to 
display all of its contents, information may be 
truncated or condensed K.

To change a column’s position:
1.	 Position the pointer on the heading for 

the column you want to move.

2.	 Press the button down and drag:

>	 To move the column to the left, drag 
to the left L.

>	 To move the column to the right, drag 
to the right.

As you drag, the pointer turns into a 
grasping hand and the other columns 
shift to make room for the column 
you’re dragging L.

3.	 When the column is in the desired posi-
tion, release the button. 

The column changes its position M.

 You cannot change the position of the 
Name column.

K When you press the button down and drag, the 
column’s width changes.

J Position the pointer on the column border.

L You can drag a column heading…

M …to change the column’s position.
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Working with 
Column View
Column view displays the contents of a 
window in multiple columns. Clicking a 
folder in one column displays the contents 
of that folder in the column to its right. 
Clicking a document or application in a 
column displays a preview or information 
about the item in the column to its right.

To display a folder’s contents:
Click the name of the folder you want to 
view the contents of.

The contents of the folder appear in the 
column to the right of the one you clicked 
in A.

To display a document preview:
Click the icon for the document you want 
to preview.

One of two things happens:

n	 If a preview for the document is avail-
able, it appears in the column to the 
right of the one you clicked in, along 
with additional information about the 
file B.

n	 If a preview is not available, the icon for 
the item appears in the column to the 
right of the one you clicked.

To move through the 
folder hierarchy:
To move through the folder hierarchy, scroll 
left or right in the window using the scroll 
bar (page 28) or gestures (page 28):

n	 Scroll left to move backward and view 
parent folders C.

n	 Scroll right to move forward and view 
child folders.

A Clicking a folder name in one column displays 
the contents of that folder in the column to its right.

B Selecting a document in column view can 
display a preview and additional information in the 
column to the right.

C Scrolling to the left moves backward through 
the file hierarchy to display parent folders.
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D Position the pointer anywhere on a column 
border if scroll bars are not displayed…

E …or on the column width handle at the bottom 
of the column if scroll bars are displayed.

F When you drag a border to the right, the 
column to the left of the border gets wider.

To change column width:
1.	 Position the pointer on the divider 

between two columns or, if column 
scroll bars are displayed, on the handle 
at the bottom of the scroll bar between 
two columns.

The pointer turns into a vertical line with 
two arrows DE.

2.	 Press the button down and drag:

>	 To make the column wider, drag to 
the right F.

>	 To make the column narrower, drag to 
the left. 

3.	 When the column is the desired size, 
release the button.

To view more or fewer columns:
Change the width of the window 
(page 26):

>	 To show more columns, make the 
window wider G.

>	 To show fewer columns, make the 
window narrower.

G You can 
view more 
columns 
by making 
the window 
wider.
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Working with 
Cover Flow
Cover Flow splits the window into two 
panes:

n	 The Cover Flow pane at the top of the 
window displays each item in the win-
dow as an icon or a preview of its first 
page.

n	 The item list pane at the bottom of the 
window displays a sortable list of the 
items in the window.

When you select an item in the item list, its 
icon or preview appears in the Cover Flow 
pane. 

You can use either pane to flip through the 
contents of a window to see item previews. 
This makes it possible to scroll through 
files to find one you’re looking for, even if 
you don’t know its name.

To flip through documents 
in Cover Flow:
Use one of the following techniques:

n	 If the scroll bar is displayed in the Cover 
Flow pane A, drag the scroller to the 
left or right to display different icons or 
previews.

n	 If you have a Multi-Touch device 
(page 13), use gestures to scroll 
icons and previews in the Cover Flow 
pane to the right or left. This works 
even if scroll bars are not displayed B.

n	 Click the icon or preview for an item in 
the Cover Flow pane.

n	 Select an item in the item list pane.

n	 Press the Up Arrow or Down Arrow key 
to display the previous or next item.

Scroll bar scroller

A You can drag the scroll bar in the Cover Flow 
pane to flip through icons and previews.

B You can also flip through items in Cover Flow if 
scroll bars are not displayed.
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To change the size of the 
Cover Flow pane:
1.	 Position the pointer on the resize box 

beneath the scroll bar in the Cover Flow 
pane.

The pointer turns into a hand.

2.	 Press the button and drag:

>	 To make the Cover Flow pane 
smaller, drag up.

>	 To make the Cover Flow pane larger, 
drag down C.

As you drag, the hand pointer seems to 
grasp the resize box C as the pane’s 
bottom border moves. 

3.	 When the pane is the desired size, 
release the button.

 The larger the Cover Flow pane is, the 
larger the icons and previews within it are C.

C Drag the resize handle down to make the 
Cover Flow pane larger, thus increasing the size of 
the icons and previews within it.
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Arranging Window 
Contents
In addition to moving icons and sorting 
lists, you can also use menu commands 
to arrange window icons by specific fields 
of information, such as kind, size, or date. 
Items are then grouped in the window by 
the arrange field you chose ABCD. 

You can arrange a window’s contents by 
nine different fields of information:

n	 Name (Control-Command-1) arranges 
items alphabetically by name.

n	 Kind A (Control-Command-2) arranges 
items alphabetically by the kind of file.

n	 Application arranges items alphabeti-
cally by the application that will open 
them.

continues on next page  

A In this example, the Documents folder is 
displayed in icon view and arranged by kind of file.

B Here’s the Documents folder again, displayed 
in list view and arranged by date modified.

Arranging vs. Sorting: 
Although both the arranging and sorting 
feature put window icons in a specific 
order—usually the same order—there is a 
difference. 

.. Arranging groups items by the 
Arrange By option you specify. Within 
each group, items can also be sorted 
by another field. So, for example, you 
can arrange (and group) items by 
kind and, within each group, sort by 
name A.

.. Sorting simply sorts items by the 
column or sort option you specify. 
There’s no grouping. Sorting is most 
often done in list or Cover Flow 
view by clicking a column heading 
(page 480), but you can also sort 
a window’s contents by choosing a 
command from the Sort By submenu 
under the View menu.
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n	 Date Last Opened (Control-Com-
mand-3) arranges items in reverse 
chronological order by the date they 
were last opened.

n	 Date Added (Control-Command-4) 
arranges items in reverse chronological 
order by the date they were added.

n	 Date Modified B (Control-Command-5) 
arranges items in reverse chrono-
logical order by the date they were last 
modified.

n	 Date Created arranges items in reverse 
chronological order by the date they 
were created.

n	 Size (Control-Command-6) arranges 
items in reverse size order. Folders 
have a size of 0 for this option unless 
you have set the window to calculate 
folder sizes (page 480).

n	 Label (Control-Command-7) arranges 
items by color-coded label (if applied; 
page 80).

n	 None (Control-Command-0) removes 
any applied arrangement option.

As shown on these pages, the Arrange 
feature works in all window views.

C The same Documents folder, this time in 
column view arranged by size.

D In this example, the Documents folder is 
displayed in Cover Flow view and arranged by 
date added.
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To arrange window contents:
1.	 Activate the window you want to 

arrange.

2.	 Use one of the following techniques:

>	 Choose a command from the 
Arrange By submenu under the View 
menu E.

>	 Choose a command from the Arrange 
pop-up menu on the window’s 
toolbar F.

>	 Press the appropriate keyboard short-
cut (page 18).

The icons are grouped in the window 
based on the Arrange By option you 
chose.

To remove arrangement 
settings from a window:
1.	 Activate the window you want to 

remove arrangement settings from.

2.	 Do one of the following:

>	 Choose View > Arrange By > 
None E.

>	 Choose None from the Arrange pop-
up menu on the window’s toolbar F.

>	 Press Control-Command-0 (zero).

E The Arrange By 
submenu under the 
View menu.

F The Arrange menu on the toolbar.
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To sort and arrange a 
window’s contents:
1.	 Activate the window you want to sort 

and arrange.

2.	 Follow the instructions on page 65 
to remove any arrangement settings 
applied to the window.

3.	 Hold down the Option key and choose 
an option from the Sort By submenu 
under the View menu G.

The items are sorted in the order you 
specified.

4.	 Follow the instructions on page 65 
to apply an arrangement option to the 
window.

The items are grouped by the arrange-
ment option and, if possible, sorted 
within each group by the sort option 
you chose in step 3.

 This doesn’t always work. It depends 
on which arrangement option is selected 
in step 4 and whether it allows sorting. For 
example, you can arrange by kind and, within 
each group, sort by name A because the 
kind option has distinct groups and no sorting 
within each group. But you cannot arrange by 
size and then sort by another field because 
within each size group, OS X sorts by size C.

 You can also sort a window’s contents by 
pressing one of the Sort By shortcut keys G.

 In icon view, you must disable the win-
dow’s sort option by choosing None from the 
Sort By submenu G to be able to move icons 
out of their sorted positions.

G Holding down the Option key turns the Arrange 
By submenu into a Sort By submenu.
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Index

802.1X option (Network preferences pane), 549

A
About This Mac window, 5
access

chat, limiting with parental controls, 575–576
email access, limiting with parental controls, 

575–576
Game Center access, limiting with parental 

controls, 575–576
optical discs, 424
user access, limiting with parental controls, 573
Web access, limiting with parental controls, 574

Accessibility pane (System preferences panes), 
590–591

Accessibility preferences pane, xxiii
Account Setup dialog, 445
accounts

adding chat accounts, 445
Administrator, 562
Group, 562
login options, 569
Mail, 546

adding, 546
email, 435–437
modifying, 547
removing, 547

Managed with Parents Controls, 562
names, 562
passwords, 563
Sharing Only, 562
Standard, 562
user

adding users, 562–563
deleting, 568
disabling parental controls, 572
enabling parental controls, 572
login items, 567
pictures, 566
settings, 565

Action pop-up menu, 29
activating windows, 25
Activity Monitor, 374–375
adding

accounts (Mail, Contacts & Calendars 
preferences pane), 546

application shortcuts, 529
buddies, 447
chat accounts, 445
items to Dock, 468
keyboard shortcuts, 528
Mail messages to Contacts, 442
printers, 534–536
sidebar items, 486
users, 562–563

address bar, Safari, xxiii
Address Book. See Contacts
Administrator account, 562
adult websites, limiting access with parental 

controls, 574
Advanced preferences, Finder, 467
Advanced section (Finder Preferences 

window), 464
AirDrop, 422–423
AirPlay Mirroring, xxi
AirPort, 398–405
AirPort Base Station, manually setting options, 

404–405
AirPort Express, creating networks, 402–403
AirPort Extreme Base Station, 398

Time Capsule, 398
AirPort Utility, 398

configuration options, 405
disabling connectivity, 405–406
enabling connectivity, 405–406
launching, 399

album art, iTunes, 201
Alert volume option, 541
Alerts option (Notification Center), 517
aliases, 82–84
All My Files option (New Finder windows), 465
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full-screen, 142–143
Game Center, 223–225
icons, 19
Image Capture, 226–229
Internet

FaceTime, 451–455
Mail, 434–442
Messages, 443–450
Safari, 456–460

launching, 137–139
Launchpad, 140–141
locking, 90
multitasking, 135–136
music, iTunes, 198–208
OS X Mountain Lion, 133–134
Photo Booth, 230–232
Preview, 233–236
Share Sheets, 149–150
shortcuts

adding, 529
removing, 529

standard menus, 153
Application, 154–156
dialogs, 166–169
Edit, 164
File, 157–163
Help, 165
Window, 165

Applications folder, 38
Home folder, 125

Apps control (parental control), 571
Arrange By icon view option (icon view 

window), 477
Arrange By option, 480
Arrange By option (column view option), 481
Arrange pop-up menu, 29
Ask to keep changes when closing documents 

option (General preferences pane), 495
Ask what to do option (CDs & DVDs pane), 520
Attach a Document to This Message button, 439
audio files, iTunes, 206
Audio option (Accessibility preferences pane), 590
Auto Save, xxii, 144
Automatic login option (Users & Groups 

preferences pane), 569
Automatic option (View Content as option), 470
Automatically adjust brightness option (Displays 

preferences pane), 522
Automatically based on mouse or trackpad option 

(General preferences pane), 494

Allow adding Game Center friends option, 575
Allow App Store Apps option (Parent Controls 

preferences pane), 573
Allow guests to connect to shared folders option 

(Users & Groups preferences pane), 561
Allow guests to log in to this computer option 

(Users & Groups preferences pane), 561
Allow joining Game Center multiplayer games 

option, 575
Allowed Apps option (Parent Controls preferences 

pane), 573
Allowed unrestricted access to websites option 

(Parent Controls preferences pane), 574
Always open folders in a new window option 

(New Finder windows), 466
Always open in column view option (column view 

option), 481
Always open in Cover Flow option, 480
Always open in icon view option (icon view 

window), 477
Always open in list view option, 480
Always option (General preferences pane), 494
Animate opening applications option (Dock 

preferences pane), 502
App Store, 133, 169

browsing, 172–173
buying apps, 174
installation, 175
launching, 170
quitting, 170
signing in, 171
signing out, 171
updating apps, 176

Appearance option (General preferences pane), 
494

Apple ID, 451
set up, 5
window, 10

Apple menu commands, Log Out, 122
Apple Mouse, 13
Apple Support website, 74
Apple website, xx
Application links, Help Center, 69
Application menu, 154–156
application modal dialogs, 166
applications, 131–132, 217

assigning specific space, 259
automated saving solutions, 144–148
Calculator, 218–219
Chess, 220
Dictionary, 221–222
force quitting, 151–152
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Help menu, 73
networks, 418–419

buddies
adding, 447
removing, 447

Buddies window, displaying, 447
burn folders, 44, 111
burning CDs & DVDs, 109–112
buttonless mouse, 14
buttonless trackpads, 14
buying apps, 174
By time option (sort order for notifications), 518
bytes, 104

C
Calculate all sizes option, 480
Calculator, 133, 218–219, 246
Calendar, xxiii, 133, 246, 297

creating, 307–308
creating events from messages, 442
events, 301–306
iCloud, 267
iCloud interface, 269, 271
launching, 297–298
quitting, 297–298
sharing, 309–313
working with window, 299–300

Calendars & Reminders option (iCloud 
preferences pane), 545

calls, FaceTime, 454–455
cameras, FaceTime, 451
Carbon Copy Cloner website, 114
CDs

adding to iTunes, 200
burning, 109–112
inserting, 520
limiting burning with parental controls, 577
mounting with slot-loading optical drive, 105
mounting with tray-loading optical drive, 106

CDs & DVDs pane (Hardware Preferences), 
519–520

CDs, DVDs, and iPods option (General Finder 
preferences), 465

character keys, 17
Character Viewer, 340
chats, 443

adding accounts, 445
limiting access with parental controls, 575–576
text, 448
video, 449–450

check boxes, 167

Automatically hide and show the Dock option 
(Dock preferences pane), 502

Automatically rearrange spaces based on most 
recent option (Mission Control preferences 
pane), 507

automation tools, 392
Automator, 133

B
Back button, 29
Back to My Mac option (iCloud preferences pane), 

545
Back up while on battery power option (Time 

Machine preferences pane), 588
Background option (icon view window), 479
backup options (Time Machine), 588–589
backups, 113

basics, 114
Time Machine, 115–117

Badge app icon (Notification Center), 517
Banners option (Notification Center), 517
battery indicator, 527
Bluetooth, 396, 408–412

browsing devices, 411
enabling/disabling, 550
File Exchange, 408
Magic Mouse, 13
sharing, 558
Status menu, 412
transferring files between computers, 409–410

Bluetooth pane (Internet & Wireless preferences 
panes), 550–552

Bluetooth preferences pane, 408–412
bookmark button, 72
bookmarks, Safari, 458
Boot Camp Assistant, 374–375
Brightness option (Displays preferences pane), 

522
Bring All to Front command, 25
Browse Device command (Status menu), 412
Browse in column view option (column view 

option), 481
Browse in Cover Flow option, 480
Browse in icon view option (icon view 

window), 477
Browse in list view option, 480
browsing

App Store, 172–173
Bluetooth devices, 411
files, Quick Look, 86
Help Center, 72
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OS X Mountain Lion, 9–10
printer sharing, 556
printers, 538
screen savers, 499–500

Connect to Server command, 418, 420
connections

Internet
connection methods, 427–428
FaceTime, 451
Network Diagnostics, 429, 431
Network Setup Assistant, 429–430

Wi-Fi, connecting to networks, 407
Console, 380
contacts, xxiii, 133, 246, 281

adding Mail messages to, 442
contact cards, organizing, 289–293
FaceTime, 451
iCloud interface, 269, 271
launching, 282
navigating interface, 283
printing, 294–295
smart groups, 293
vCards

creating, 287–288
importing, 287–288
organizing, 289–293

working with cards, 284–286
Contacts option (iCloud preferences pane), 545
content filter, limiting web access, 574
contextual menus, 15–16
Control keys, 17
Control-Up Arrow keystroke, 254
Controller, DVD Player, 215
copying

files, 46–47
spring-loaded folders, 79

Finder, xxii
text with TextEdit, 187–188

Cover Flow, 61–62
view options (view options window), 480
view setting (view options window), 476
views, 52

Cover Flow pane, 62
crashes (computer), kernel panics, 524
Crayons option (Colors panel), 496
Create Your Computer Account window, 10
creating

AirPort Express networks, 402–403
aliases, 83
Calendar, 307–308

Chess, 133, 220
Clean Up command (View menu), 54
Click in the scroll bar to option (General 

preferences pane), 495
clicking, 13
clipboard, 187
clock, setting, 582
close button, 23
Close command (File menu), 159
Close Window command (File menu), 159
Close windows when quitting an application 

option (General preferences pane), 495
closing

AirDrop, 423
Dashboard, 240
Launchpad, 141
Mission Control, 254
widgets, 243

Cloud. See also iCloud
Color option (Background of icon view 

window), 479
Color Palettes option (Colors panel), 496
Color Sliders option (Colors panel), 496
Color Wheel option (Colors panel), 496
color-coded labels, 80–81
ColorSync Utility, 377–379
Column view setting (view options window), 476
columns

headings, 23
view options (view options window), 481
views, 52, 58–60

Command keys, 17
commands

Bluetooth Status menu, 412
Connect to Server, 418, 420

Compress command (File menu), 91
compressing files & folders, 91
Computer name option (New Finder 

windows), 465
computers

changing state of work, 35–36
identity, setting, 554
processors, version, 5
time, limiting with parental controls, 576

configuring
AirPort Utility, 405
Bluetooth sharing, 558
diction, 585
file sharing, 555
Internet sharing, 557
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deleting
contact cards, 286, 292
printer pools, 539
printers, 536
Reminders, 320
Smart folder, 101
text with TextEdit 187–188, 101
user accounts, 568

deselecting icons, 20–21
Desktop & Screen Saver pane (Personal 

Preferences), 494, 497–500
Desktop folder, Home folder, 125
Desktop option (New Finder windows), 465
desktop view options (view options window), 482
Desktop view setting (view options window), 476
desktops

Finder, 12
management, 249

Expose, 255–256
Mission Control, 253–259
Notification Center, 260–261
Spaces, 257–259
Stacks, 250–252

pictures, 497–498
printers, creating, 539

Device Name command (Status menu), 412
devices

AirPort Extreme Base Station, 398
browsing with Bluetooth, 411
pairing, 552

Devices lists, 31
diagnostics

Network Diagnostics, 429, 431
Network Setup Assistant, 429–430

dial-up connections (Internet), 428
dialogs

Account Setup, 445
Customize Toolbar, 483
Options & Supplies, 538

dictation, xx
configuring, 585
enabling, 585
limiting usage with parental controls, 577
TextEdit, 192–193

Dictation & Speech pane (System preferences 
panes), 585–587

Dictionary app, xxiii, 133, 221–222, 246
digital cameras, Image Capture, 227–228
DigitalColor Meter, 381
direct connections (Internet), 428

Calendar events from email messages, 442
desktop printers, 539
groups, 564
input menus, Language & Text preferences 

pane, 506
messages (Mail), 438
printer pools, 539
Smart folder, 100
Time Capsule networks, 399–401
vCards, 287–288

criteria filters, 97
Customize Toolbar dialog, 483
customizing

Finder, 463–474
arranging menu bar icons, 474
Dock, 468–470
Finder preferences, 464–467
Launchpad, 471–473
windows, 476–486

input menus, Language & Text preferences 
pane, 506

keyboard shortcuts, 528
labels, 466
sidebar (Finder windows), 485–486
System Preferences, 492
toolbar (Finder windows), 483–484

Cycle Through Windows command, 25

D
Dashboard, 133, 239

browser display, 241
closing, 240
opening, 240
widgets

browser, xxiii
managing, 244–245
OS X overview, 246–248
utilizing, 242–243

databases, 131
Date & Time pane (System preferences panes), 

579–582
dates

setting, 579–581
setting in Language & Text preferences pane, 

505
default printers, setting, 537
Del keys, 17
Delay option (text to speech), 586
Delay Until Repeat option (Keyboard preferences 

pane), 526
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iCloud, 274–275
icons, 19
launching applications, 137
locking, 90
locking for editing, 147
moving, 146
Preview, 233–236
print previewing, 350
printing, 354
renaming, 146
reverting to last saved version, 148
saving, 160–162
scanners, 228–229
Share Sheets, 149–150
TextEdit

opening, 196
saving, 194–195

unlocking, 147
Documents & Data option (iCloud preferences 

pane), 545
Documents folder, Home folder, 125
Documents option (New Finder windows), 465
Double-click a window’s title bar to minimize 

option (Dock preferences pane), 502
Double-Click option (Mouse preferences  

pane), 530
double-clicking, 13
downloads, OS X Mountain Lion, 6
Downloads folders, Home folder, 125
dragging, 13

files to Trash, 49
drivers, printing, 342
Drop Box folders, 126
Drop Box website, 114
DUN (dial-up network service), 428
DVD or CD Sharing option (Sharing preferences 

pane), 553
DVD Player, 133, 215–216
DVDs

burning, 109–112
inserting, 520
limiting burning with parental controls, 577
mounting with slot-loading optical drive, 105
mounting with tray-loading optical drive, 106

E
Edit menu commands, 164

Redo, 92
Undo, 92

Disable use of Dictation option, 577
disabling

AirPort connectivity, 405–406
Bluetooth, 550
Guest User account, 561
iCloud, 279
parental controls, 572
password changes, 577

Discoverable option (Bluetooth preferences 
pane), 550

Disk Utility, 359
image files, 368–372
launching, 360
partitioning disks, 364–367
quitting, 360
repairing disks, 362–363
volume, 361

Disk Utility option (OS X Utilities dialog), 120
disks

burning iTunes content, 207
mounting, 105–106

Display Calibrator Assistant, 522
Display login window as option (Users & Groups 

preferences pane), 569
Display option (Accessibility preferences  

pane), 590
display options

color, 522
setting, 521–522

displaying
Buddies window, 447
Safari top sites, 460
stack folders, 470

Displays pane (Hardware Preferences), 519, 
521–522

DNS option (Network preferences pane), 549
Dock

application multitasking, 135–136
customizing, 468–470
Finder interface, 12
icons, 468–469
spring-loaded folders, 78–79

Dock pane (Personal Preferences), 494, 501–502
docks, Finder, 34
document model dialogs, 166
documents

browsing versions, 148
Cover Flow, 61
duplicating, 147
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enabling
AirPort connectivity, 405–406
Bluetooth, 550
Bluetooth sharing, 558
diction, 585
FaceTime, 453
file sharing, 555
Internet sharing, 557
parental controls, 572
printer sharing, 556

Energy Saver pane (Hardware Preferences), 
519, 523–525

enhance icon view, 22
entry fields, 167
erasing disks, Disk Utility, 364–367
ESPN, 246
Ethernet, 396, 413
events, Calendar, 301–306
everyone privileges, 416
exporting, Photo Booth, 232
Expose, 249

desktop management, 255–256
External disks option (General Finder 

preferences), 465
external hard disks, mounting, 106
external storage devices, 104

F
Facebook, xxi
FaceTime, 133, 451–455

calls, 454–455
Contacts, 451
enabling, 453
logging in, 453
microphones, 451
opening, 452
requirements, 451
turning off, 455

Fan option (View Content as option), 470
fast user switching, 124
Favorites, 31
faxes, PDF documents, 353
File menu commands, 157–163

Close, 159
Close Window, 159
Compress, 91
Find, 97–98
Get Info, 90
Make Alias, 83
Move to Trash, 49
New, 157

editing
contact cards, 287
Smart folder, 101
TextEdit, xxiii, 134, 177

copying text, 187–188
cutting text, 187–188
deleting text, 181
dictation, 192–193
entering text, 179
formatting text, 182–184
grammar check, 189–191
indentations, 185
inserting text, 180
launching, 178
opening documents, 196
pasting text, 187–188
quitting, 178
redoing actions, 186
replacing text, 181
saving documents, 194–195
selecting, 181
spell check, 189–191
tab stops, 184–185
undoing actions, 186

effects, sound, 541
email

addresses, iCloud, 268
limiting access with parental controls, 575–576
Mail, 434–442

adding messages to Contacts, 442
creating Calendar events from email, 442
creating messages, 438
enhancing messages, 439
forwarding messages, 441
opening, 435
reading messages, 440
replying to messages, 441
retrieving messages, 440
sending messages, 438
setting up accounts, 435–437

Empty Trash securely option (Advanced Finder 
preferences), 467

emptying Trash, 50
Enable Location Services window, 9
Enable parental controls option (Users & Groups 

preferences pane), 561
Enable Power Nap while on battery power option 

(Energy Saver preferences pane), 524
Enable Power Nap while plugged into a power 

adapter option (Energy Saver preferences 
pane), 524
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privileges, 416
restoring, Time Machine, 117–118
searching, 93

Find command, 97–98
results, 102
Search field, 96
Smart folders, 99–101
Spotlight menu, 94–95

sharing, 418–421
AirDrop, 423
multiple users, 126–127

FileVault option (Security & Privacy preferences 
pane), 508, 510–511

filters, criteria, 97
Find command (Find menu), 97–98
Find My iPhone, iCloud interface, 269
Find My Mac, iCloud, 277–278
Find My Mac option (iCloud preferences 

pane), 545
Finder, 11

advanced techniques, 77
aliases, 82–84
color-coded labels, 80–81
compressing files & folders, 91
Info window, 88–90
moving items, 46–47
naming files, 43
pathnames, 39–40
Quick Look, 86–87
recent items, 85
spring-loaded folders, 78–79
Trash, 48–50
undoing actions, 92

changing state of computer, 35
copying, xxii
customizing, 463–474

arranging menu bar icons, 474
Dock, 468–470
Finder preferences, 464–467
Launchpad, 471–473
windows, 476–486

dock, 34
icons, 19–22
installing Font Book, 328
interface, 12
keyboard, 17–18
menus, 15–16
mouse, 13–14
Printer command, 357
sidebar, 31–32
status bar, 33

File menu commands (continued)
New Burn Folder, 111
New Folder, 45
New Smart Folder, 100
Open, 158
Open With, 139
Put Back command, 49
Quick Look “file name,” 86
Save, 160

file sharing
configuring, 555
enabling, 555

File Sharing option (Sharing preferences 
pane), 553

files
accessibility to other users, 127–128
column views, 59–60
compressing, 91
File menu commands, 157–163

Close, 159
Close Window, 159
Compress, 91
Find, 97–98
Get Info, 90
Make Alias, 83
Move to Trash, 49
New, 157
New Burn Folder, 111
New Folder, 45
New Smart Folder, 100
Open, 158
Open With, 139
Put Back command, 49
Quick Look “file name,” 86
Save, 160

Guest User account, 561
iCloud storage, xxi, 114, 265

disabling, 280
enabling iWork apps, 276
Find My Mac, 277–278
managing storage, 279
setting up, 266–268
using with iWork, 273–276
website interface, 269–272

management, 37
color-coded labels, 80–81
copying items, 46–47
duplicating items, 47
folders, 44–45
Go menu, 41–42
hierarchical filing system, 38
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Font Book, 133, 327
installing from Finder, 328
launching, 328
quitting, 328

fonts, 325
Character Viewer, 340
Font Book, 327–336
Fonts Panel, 337–339
formats, 325
TextEdit formatting text, 183

Fonts Panel, 337–339
forces, quitting applications, 151–152
formatted storage media, 104
formatting

fonts, 325
text, TextEdit, 182–185

Forward button, 29
forwarding, messages (Mail), 441
full- screen views, 87
full-screen applications, 142–143
full-screen views, 142–143
function keys, 17

G
Game Center app, xxi, 134, 223–225

limiting access with parental controls,  
575–576

games, 131
Gatekeeper, xxi
Gatekeeper options (Security & Privacy 

preferences pane), 508–510
General options

Finder preferences, 465–466
Security & Privacy preferences pane, 508–510

General pane (Personal Preferences), 494–496
General section (Finder Preferences window), 464
Genius playlists, iTunes, 206
Get Help Online option (OS X Utilities dialog), 120
Get Info command (File menu), 90
gigabytes, 104
Go menu, 41–42
Google, troubleshooting advice, 74
Grab, 382–383
grammar check, TextEdit, 189–191
Grapher, 384
graphics applications, 131
Grid option (View Content as option), 470
Grid spacing option (desktop view options), 482
Grid spacing option (icon view window), 478
Group account, 562

toolbar, 29–30
trackpad, 13–14
window views, 51–52

activating, 53
arranging contents, 63–66
column view, 59–60
Cover Flow, 61–62
icon view, 54
list view, 55–58

windows, 23–28
sidebars, 485–486
toolbar, 483–484
view options, 476–482

Finder preferences
Advanced, 467
General, 465–466
opening, 464
setting, 464–467
Sidebar, 466

Finder Preferences window, 464
finding preferences panes, 490
Finger screen (Network Utility), 425
Firewall option (Security & Privacy preferences 

pane), 508, 512
FireWire, 396, 414
flash drives, 104
Flight Tracker, 247
Folder for accepted items option (Sharing 

preferences pane), 558
Folder option (Display as option), 470
Folder others can browse option (Sharing 

preferences pane), 558
folders

burning from burn folder, 111
burning to CD or DVD, 110
column views, 59–60
compressing, 91
creating, 45
icons, 19
Launchpad

arranging icons by, 472
removing items from, 473
renaming, 473

management, 44–45
privileges, 416
restoring, Time Machine, 117–118
Smart, 99–101
spring-loaded, 78–79
stack, customizing display, 470
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I
iCal. See Calendar
iCloud, xxi, 114, 265

disabling, 280
enabling iWork apps, 276
Find My Mac, 277–278
managing storage, 279
setting up, 266–268
using with iWork, 273–276
website interface, 269–272

iCloud pane (Internet & Wireless preferences 
panes), 544–545

iCloud preferences pane, 266
enabling iCloud services, 545
signing in iCloud, 544

Icon & Text option (Show pop-up menu), 484
Icon Only option (Show pop-up menu), 484
Icon size option, 480

desktop view options, 482
icon view window, 478

Icon view setting (view options window), 476, 477
icons

Dock, 468–469
Finder interface, 12
Launchpad, 471–472
menu bar, 474
preferences panes, showing, 489
size control, 23
views, 52, 54

ide profanity option, 577
IDs, 415
Ignore option (CDs & DVDs pane), 520
Illuminate keyboard in low light conditions option 

(Keyboard preferences pane), 527
Image Capture, 134, 226–229
Image files, Preview, 233–236
Image Palettes option (Colors panel), 496
images

contact cards, 287
Image Capture, 226–229
Photo Booth, 230–232
Preview, 233–236

iMessages, 443
reading messages, 448
responding to messages, 448
sending, 446
setting up Messages for, 444

importing
music, iTunes, 201
vCards, 287–288

Group windows by application option (Mission 
Control preferences pane), 507

groups, 415
contact cards, 291
creating, 564
privileges, 416

Guest User account options, 561

H
Hard Disk name option (New Finder 

windows), 465
hard disks

disconnecting, 108
external, mounting, 106
restoring, Time Machine, 118
unmounting, 107

Hard disks option (General Finder 
preferences), 465

hard drives (HDs), 104
Hardware option (Network preferences 

pane), 549
Hardware preferences pane, 488
Hardware preferences panes, 519–542

CDs & DVDs, 519–520
Displays, 519, 521–522
Energy Saver, 519, 523–525
Keyboard, 519, 526–529
Mouse, 519, 530–531
Trackpad, 519, 532–533

HDs (hard drives), 104
help. See also Help Center; Help Tags

troubleshooting advice, 74
Help Center, 67, 69

application from within, 71
browsing Help menu, 73
opening, 70

Help menu
browsing, 73
commands, 165

Help Tags, 67–68
HFS (hierarchical filing systems), 38
Hide profanity option, 577
hierarchical filing systems (HFS), 38
Highlight Color option (General preferences 

pane), 494
Home folder, 125
hot corners (screen savers), 500
hotspots

mobile, 428
Wi-Fi, 428, 432
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iTunes, 134
adding songs from audio CD, 200
album art, 201
browse source list, 202
burning to disc, 206
importing music, 201
launching, 198–199
play content, 203
playlists, 204–206
quitting, 198–199

iWork
enabling apps, 276
iCloud interface, 269
using with iCloud, 273–276

J
Jump to the next page option (General 

preferences pane), 495
Jump to the spot that’s clicked option (General 

preferences pane), 495

K
kernel panics, 524
Key Repeat option (Keyboard preferences 

pane), 526
keyboard equivalents, 18
Keyboard option (Accessibility preferences 

pane), 590
Keyboard pane (Hardware Preferences), 519, 

526–529
Keyboard preferences panes, 18
keyboard shortcuts, 18

customizing, 528
Expose, 255
Spotlight, 516

keyboards, Finder, 17–18
Keychain Access, 385–386
kilobytes, 104

L
Label position option (desktop view options), 482
Label position option (icon view window), 478
labels

color-coded, 80–81
customizing, 466

Labels section (Finder Preferences window), 464
Language & Text pane (Personal Preferences), 

494, 503–506
Language option (diction), 585
Languages, Info window, 89

indentations, TextEdit, 185
Info screen (Network Utility), 425
Info window, 88–90
initialized storage media, 104
input devices, 542
input menus

creating, 506
customizing, 506

Input Sources button, 527
inserting CDs/DVDs, 520
installing

apps from App Store, 175
OS X Mountain Lion, 7–8
software updates, 584
widgets, 244

instant messages, Messages, 443–450
interfaces

Mail, 434
networking, 396–397

Bluetooth, 396, 408–412
Ethernet, 396, 413
FireWire, 396, 414
Modem, 396
Wi-Fi, 396, 406–407

internal storage devices, 104
Internet

applications
FaceTime, 451–455
Mail, 434–442
Messages, 443–450
Safari, 456–460

connections
connection methods, 427–428
FaceTime, 451
Network Diagnostics, 429, 431
Network Setup Assistant, 429–430

sharing, 557
Internet & Wireless preferences panes, 488, 

544–558
Bluetooth, 550–552
iCloud, 544–545
Mail, Contacts & Calendars, 546–547
Network, 548–549
Sharing, 553–558

Internet access applications, 131
Internet Service Providers (ISPs), 428
Internet Sharing option (Sharing preferences 

pane), 553
invisible grids, windows, 54
iPhoto icon, 19
ISPs (Internet Service Providers), 428



612  Index

Mail, 134, 434–442
adding messages to Contacts, 442
creating Calendar events from email, 442
creating messages, 438
enhancing messages, 439
forwarding messages, 441
interface, 434
opening, 435
reading messages, 440
replying to messages, 441
retrieving messages, 440
sending messages, 438
setting up accounts, 435–437
VIPs, xxiii

mail, iCloud interface, 269, 271
Mail option (iCloud preferences pane), 545
Mail, Contacts & Calendars pane (Internet & 

Wireless preferences panes), 546–547
Main help Center window, Help Center, 69
Make Alias command (File menu), 83

File menu commands, 83
Manage parental controls from another computer 

option, 572
Managed with Parents Controls account, 562
management

desktops, 249
Expose, 255–256
Mission Control, 253–259
Notification Center, 260–261
Spaces, 257–259
Stacks, 250–252

files, 37
aliases, 82–84
color-coded labels, 80–81
copying items, 46–47
duplicating items, 47
folders, 44–45
Go menu, 41–42
hierarchical filing system, 38
Info window, 88–90
moving items, 46–47
naming files, 43
pathnames, 39–40
Quick Look, 86–87
recent items, 85
Trash, 48–50

folders, 44–45
iCloud storage, 279

Manually option (sort order for notifications), 518
Maria’s Guides website, xix

launching
AirPort Utility, 399
App Store, 170
applications, 137–139
Calendar, 297–298
Disk Utility, 360
DVD Player, 215
Font Book, 328
iTunes, 198–199
QuickTime Player, 209
TextEdit, 178

Launchpad, xxii, 134
applications, 140–141
folders

arranging icons by, 472
removing items from, 473
renaming, 473

icons, 471–472
organizing, 471–473

Library folders, 38
Home folder, 125

Limit Mail option, 575
Limit Messages option, 575
links, Safari, 456
List always option (View Content as option), 470
list view options (view options window), 480
List view setting (view options window), 476
list views, 52
locking System Preferences, 491
Log Out command (Apple menu), 122
logging out, multiple users, 122–123
Login Options of the Users & Groups preferences 

pane, 123
logins

FaceTime, 453
multiple users, 122–123
options, accounts, 569
user accounts, 567

logs, reviewing, 578
Look up option, 532
Lookup screen (Network Utility), 425

M
MacFixit website, 74
MacLife magazine, troubleshooting advice, 74
Macworld magazine, troubleshooting advice, 74
magazines, troubleshooting advice, 74
Magic Mouse, 13, 531
Magic Trackpad, 532
Magnification option (Dock preferences 

pane), 501
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Minimize windows using option (Dock 
preferences pane), 501

Mission Control, 134, 249
desktop management, 253–254

Mission Control option (More Gestures 
button), 531

Mission Control pane (Personal Preferences), 
494, 507

mobile hotspots, 428
modeless dialogs, 166
Modem app, 396
modem connections (Internet), 428
modifier keys, 17
More Gestures options, 533
More Info, Info window, 89
mounted storage media, 104
mounting disks, 105–106
Mouse & Trackpad option (Accessibility 

preferences pane), 591
Mouse and Trackpad preferences panes, 13
Mouse pane (Hardware Preferences), 519, 

530–531
Move to Trash command (File menu), 49
movies

editing applications, 131
Photo Booth, 230–232
QuickTime Player, 134

exporting movie, 213–214
launching, 209
opening file, 210
playing a movie, 211
quitting, 210
recording a movie, 212
sharing movie, 213–214
size specifications, 211

Movies app, 247
Movies, Music, and Pictures folder, Home 

folder, 125
moving

files, 46–47
spring-loaded folders, 79
to Trash, 49

icons, 20–21
menu bar icons, 474
widgets, 243
windows, 26

Multi-Touch gestures, 531
multiple contiguous icons, list view, 57
multiple noncontiguous icons, list view, 57

media, 103–104
burning CDs & DVDs, 109–112
disconnecting hard disk, 108
mounting disks, 105–106
unmounting & ejecting optical disk, 108
unmounting hard disk, 107

media cards, Image Capture, 227–228
Media Eject keys, 108
megabytes, 104
memory, 104
menu bar

arranging icons, 474
Finder interface, 12
icons, 474

menus
applications, 153

Application, 154–156
dialogs, 166–169
Edit, 164
File, 157–163
Help, 165
Window, 165

Bluetooth Status, 412
Finder, 15–16
Wi-Fi Status, 405–406

Messages, xx, 134, 443–450
opening, 444
setting up for iMessages, 444

messages
iMessage

reading, 448
responding to, 448

Mail
adding, 442
adding to Contacts, 442
creating, 438
creating Calendar events from, 442
enhancing, 439
forwarding, 441
reading, 440
replying to, 441
retrieving, 440
sending, 438

microphones, FaceTime, 451
Microsoft Office files, Preview, 233–236
Migration Assistant, 387
minimize button, 23
Minimize windows into application icon (Dock 

preferences pane), 502
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Modem, 396
Wi-Fi, 396, 406–407

Network Utility, 425–426
remote discs, 424
status checks, 397
Wi-Fi connections, 407, 548–549
Wi-Fi Status menu, 405–406

New Burn Folder command (File menu), 111
New command (File menu), 157
New Finder Window command, 24
New Folder command (File menu), 45
New Smart Folder command (File menu), 100
No Access privileges, 416
None option (Notification Center), 517
notes, 315
Notes app, xxi, 134, 321–322
Notes option (iCloud preferences pane), 545
Notification Center, 249, 316, xx

desktop management, 260–261
options, 517–518

Notifications pane (Personal Preferences), 494, 
517–518

Notifications preferences pane, 316
Notify after old backups are deleted option (Time 

Machine preferences pane), 588
numbers, setting in Language & Text preferences 

pane, 505

O
On option (Bluetooth preferences pane), 550
one-button mouse, 14
online file storage, iCloud, 114, 265, xxi

disabling, 280
enabling iWork apps, 276
Find My Mac, 277–278
managing storage, 279
setting up, 266–268
using with iWork, 273–276
website interface, 269–272

Online information links, Help Center, 69
Open application name option (CDs & DVDs 

pane), 520
Open Bluetooth Preferences command (Status 

menu), 412
Open command (File menu), 158
Open other application option (CDs & DVDs 

pane), 520
Open with, Info window, 89
Open With command (File menu), 139
Open With submenu, 139

multiple users, 121
fast user switching, 124
Home folder, 125
logging out & in, 122–123
sharing files, 126–127

multitasking, applications, 135–136
music, iTunes

adding songs from audio CD, 200
album art, 201
browse source list, 202
importing music, 201
launching, 198–199
play content, 203
playlists, 204–206
quitting, 198–199

Mute option (Sound preferences pane), 540

N
Name & Extension, Info window, 89
names

accounts, 562
files, 43
Launchpad folders, 473
users, 415

Netstat screen (Network Utility), 425
Network Account Server option (Users & Groups 

preferences pane), 570
network browser, 418–419
Network Diagnostics, 429, 431
Network pane (Internet & Wireless preferences 

panes), 548–549
Network Setup Assistant, 429–430
Network Utility, 425–426
networking, 395

AirDrop, 422–423
AirPort, 398–405
Bluetooth, 408–412

browsing devices, 411
Status menu, 412
transferring files between computers, 

409–410
connections (Internet), 428
creating AirPort Express networks, 402–403
creating Time Capsule networks, 399–401
Ethernet, 413
FireWire, 414
interfaces, 396–397

Bluetooth, 396, 408–412
FireWire, 396, 414
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P
Page Setup dialog, 344
pairing devices, 552
panes

Bluetooth preferences, 408–412
buttons, 167
Hardware preferences, 519–542

CDs & DVDs, 519–520
Displays, 519, 521–522
Energy Saver, 519, 523–525
Keyboard, 519, 526–529
Mouse, 519, 530–531
Trackpad, 519, 532–533

Internet & Wireless preferences, 544–558
Bluetooth, 550–552
Mail, Contacts & Calendars, 546–547
Network, 548–549
Sharing, 553–558

Personal preferences
Desktop & Screen Saver, 494, 497–500
Dock, 494, 501–502
General, 494–496
Language & Text, 494, 503–506
Mission Control, 494, 507
Notifications, 494, 517–518
Security & Privacy, 494, 508–513
Spotlight, 494, 514–516

System preferences, 488–491, 560–592
Accessibility, 590–591
Date & Time, 579–582
Diction & Speech, 585–587
Parental Controls, 571–578
Software Update, 583–584
Startup Disk, 592
Time Machine, 588–589
Users & Groups, 560–570

Users & Groups preferences, 415
paper size, 537
Paper Tape window, 218
parental controls

disabling, 572
enabling, 572
limiting access with, 573–577
limiting user access, 573
reviewing access logs, 578

Parental Controls pane (System preferences 
panes), 571–578

partitioning disks, Disk Utility, 364–367
passkeys, pairing devices, 552

opening
AirDrop, 422
Dashboard, 240
documents, TextEdit, 196
FaceTime, 452
Finder preferences, 464
Help Center, 70
icons, 21
Launchpad, 141
Mail, 435
Messages, 444
Mission Control, 254
print queues, 537
Safari, 456
Smart folder, 101
Spotlight menu search, 95
stack items, 251
System Preferences, 489
widgets, 242

optical discs
accessing, 424
unmounting & ejecting, 108

optical drives, 104
Options & Supplies dialog, 538
organizing widgets, 245
OS X Hints website, 74
OS X Mountain Lion

downloading, 6
features

improved features, xxiii
new, xx–xxi
System & Finder improvements, xxii

installer, 7–8
purchasing, 6
networking, 397
setting up, 3

configuration, 9–10
installation, 4–8

updates, 5
OS X Setup Assistant, 427

setting up user accounts, 560
OS X Utilities dialog, 120
Other control (parental control), 571
Other option (New Finder windows), 465
Other preferences pane, 488
outline list views, 56
output devices, 542
Output volume option (Sound preferences 

pane), 540
owners, privileges, 416
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Pointer, Finder interface, 12
pointing, 13
pop-up menus, 15, 167
Port Scan screen (Network Utility), 425
ports

Ethernet, 413
FireWire, 414

Position on screen option (Dock preferences 
pane), 501

Power Nap, xxii
preemptive multitasking, 135
preferences

Finder
Advanced, 467
General, 465–466
opening, 464
setting, 464–467
Sidebar, 466

Hardware, panes, 519–542
Personal, 494–518

Desktop & Screen Saver pane, 494, 
497–500

Dock pane, 494, 501–502
General pane, 494–496
Language & Text pane, 494, 503–506
Mission Control pane, 494, 507
Notifications pane, 494, 517–518
Security & Privacy pane, 494, 508–513
Spotlight pane, 494, 514–516

System, 488–492
customizing, 492
locking/unlocking, 491
opening, 489
panes, 488
quitting, 490

presentation applications, 131
Preview, 134, 233–236

Info window, 89
preview areas, 167
Preview icon, 19
Print dialog, 345–249
Printer Sharing option (Sharing preferences 

pane), 553
printers

adding, 534–536
administration, limiting with parental 

controls, 577
configuring, 538
deleting, 536
desktop, 539

Password Assistant, 563
passwords, 415

accounts, 563
changing on server, 421
disabling, 577

pathnames, file management, 39–40
PDFs

Preview, 233–236
saving documents, 351–353

Peachpit website, xx
People control (parental control), 571
permissions, setting, 417
personal information management 

applications, 131
Personal preferences panes, 488, 494–518

Desktop & Screen Saver pane, 494, 497–500
Dock pane, 494, 501–502
General pane, 494–496
Language & Text pane, 494, 503–506
Mission Control pane, 494, 507
Notifications pane, 494, 517–518
Security & Privacy pane, 494, 508–513
Spotlight pane, 494, 514–516

photo applications, 131
Photo Booth, 134
Photo Stream

iCloud retrieval, 272
photos, 545

Photo Stream option (iCloud preferences 
pane), 545

photos. See also pictures
Photo Stream, 545

iCloud retrieval, 272
Phrase option (text to speech), 586
Picture option (Background of icon view 

window), 479
pictures. See also photos

desktop, 497–498
Image Capture, 226–229
Photo Booth, 230–232
Preview, 233–236
user accounts, 566

Ping screen (Network Utility), 425
Play feedback when volume is changed 

option, 541
Play sound effects through option, 541
Play sound when receiving notifications option 

(Notification Center), 517
Play user interface sound effects option, 541
playlists, iTunes, 204–206
Point & Click options, 532–533
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opening file, 210
playing a movie, 211
quitting, 210
recording a movie, 212
sharing movie, 213–214
size specifications, 211

quitting. See also turning off
App Store, 170
Calendar, 297–298
Disk Utility, 360
DVD Player, 215
Font Book, 328
QuickTime Player, 210
System Preferences, 490
TextEdit, 178

R
radio buttons, 167
RAID devices, 104
RAM (random access memory), 104
Read & Write Only privileges, 416
Read & Write privileges, 416
Read Only privileges, 416
Reading List (Safari), reading pages, 459
reading messages

iMessage, 448
Mail, 440

recent items, file management, 85
Recent Items option (General preferences 

pane), 495
recoveries, 113

backups, 113
basics, 114
Time Machine, 115–117

partition, 119–120
Redo command (Edit menu), 92
Register window, 10
Registration Information window, 10
Reinstall OS X option (OS X Utilities dialog), 120
Related Topics links, Help Center, 69
reminders, 315
Reminders app, xxi, 134, 315–320
Remote Apple Events option (Sharing preferences 

pane), 553
Remote Disc, 424
Remote Login option (Sharing preferences 

pane), 553
Remote Management option (Sharing preferences 

pane), 553

pools
creating, 539
deleting, 539

sharing
configuring, 556
enabling, 556

printing, 341
basics, 342–343
contacts, 294–295
Desktop printers, 354
documents, 354
Finder Printer command, 357
Page Setup dialog, 344
PDF files, 351–353
preferences, 534
previewing documents, 350
Print dialog, 345–249
queues, 354–356
sharing printers, 343

Privacy options (Security & Privacy preferences 
pane), 508, 513

Privacy options (Spotlight pane), 514
privileges, 416

everyone, 416
groups, 416
No Access, 416
owners, 416
Read & Write, 416
Read Only, 416
Write Only, 416

profanity, hiding with parental controls, 577
protected memory, 135
Proxies option (Network preferences pane), 549
Public folders, 126

Home folder, 125
pull-down menus, 15
punctuation, commands, 192
push buttons, 167
Put Back command (File menu), 49
Put hard disks to sleep when possible option 

(Energy Saver preferences pane), 523

Q
Quick Event feature, 302
Quick Look, file management, 86–87
Quick Look “file name” command (File menu), 86
QuickTime Player, 134

exporting movie, 213–214
launching, 209
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Scanner Sharing option (Sharing preferences 
pane), 553

scanners
documents, 228–229
Image Capture, 226–229

scanning preferences, 534
scheduling startups, 525
School nights option, 576
Screen Saver app, xxii
screen savers, configuring, 499–500
Screen Savers module, 499
Screen Sharing option (Sharing preferences 

pane), 553
Scroll & Zoom options, 533
scroll bars, 23
scrolling

calendar dates, 300
windows, 28

Scrolling option (Mouse preferences pane), 530
SD cards, 104
search boxes, Safari, xxiii
Search feature, Help Center, 69
Search field, 29

files, 96
search fields, 23
search locations, 97
Search Results options (Spotlight pane), 514
searches

contact cards, 289
excluding locations from, 515
files, 93

Find command, 97–98
results, 102
Search field, 96
Smart folders, 99–101
Spotlight menu, 94–95

Launchpad, 141
Safari, 457

Secondary Click option, 532
Secure Empty Trash command, 50
Security & Privacy pane (Personal Preferences), 

494, 508–513
security updates, xxii
Select New Original dialog, 83
Select Your Keyboard window, 9
Select Your Time Zone window, 10
Select Your Wi-Fi Network window, 9
selecting

icons, 20–21
startup disks, 592
text, TextEdit, 181

removing
accounts (Mail, Contacts & Calendars 

preferences pane), 547
application shortcuts, 529
buddies, 447
items from Dock, 469
items from Launchpad folders, 473
locations from searches, 515
sidebar items, 486
widgets, 245

replying to messages (Mail), 441
requirements

FaceTime, 451
OS X Mountain Lion installation, 4

resizing windows, 26
Resolution option (Displays preferences 

pane), 521
restarting computers, 35–36
Restore Defaults button, 524, 528
Restore From Time Machine Backup option  

(OS X Utilities dialog), 120
restoring

documents versions, 148
recovery partition, 119–120
Time Machine, 117–118
toolbar default settings, 484

Resume, 144
retrieving messages (Mail), 440
Revert, 144
reviewing access logs, 578
right-clicking, 13
Run script option (CDs & DVDs pane), 520

S
Safari, 134, 456–460

address bar, xxiii
bookmarks, 458
displaying top sites, 460
links, 456
opening, 456
Reading List, 459
saving Web pages, 459
search boxes, xxiii
searches, 457
sharing Web pages, 460

Safari option (iCloud preferences pane), 545
Save command (File menu), 160
saving

documents, 160–162, 194–195
Web pages, 459
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Show icon preview option, 480
Show icon preview option (column view 

option), 481
Show icon preview option (desktop view 

options), 482
Show icon preview option (icon view window), 478
Show icons option (column view option), 481
Show in Notification Center option (Notification 

Center), 517
Show indicator lights for open applications option 

(Dock preferences pane), 502
Show Input menu in login window option (Users & 

Groups preferences pane), 569
Show item info option (desktop view options), 482
Show item info option (icon view window), 478
Show Keyboard & Character Viewers in menu bar 

option (Keyboard preferences pane), 527
Show mirroring options in the menu bar when 

available option (Displays preferences 
pane), 522

Show or Hide the Photo Browser button, 439
Show or Hide the Stationary Pane button, 439
Show password hints option (Users & Groups 

preferences pane), 569
Show preview column option (column view 

option), 481
Show scroll bars option (General preferences 

pane), 494
Show the Sleep, Restart, and Shut Down buttons 

option (Users & Groups preferences 
pane), 569

Show Toolbar command (View menu), 53
Show volume in menu bar option (Sound 

preferences pane), 540
Show warning before changing an extension 

option (Advanced Finder preferences), 467
Show warning before emptying the Trash 

(Advanced Finder preferences), 467
shutting down

computers, 35–36
scheduling shutdowns, 525

Sidebar icon size option (General preferences 
pane), 494

Sidebar preferences, 466
Sidebar section (Finder Preferences window), 464
sidebars, 23

Finder, 31–32
Finder window, 485–486

signing into iCloud, 544
Simple Finder, 573
Size option (Dock preferences pane), 501
Ski Report, 247

seminars, help advice, 74
Send File command (Status menu), 412
sending

iMessages, 446
messages (Mail), 438

Set Date and Time window, 10
Set up Bluetooth Device command (Status 

menu), 412
Set Up iCloud window, 10
setting

clock, 582
computer identity, 554
dates, 579–581
permissions, 417
time, 579–581
time zone, 581

Setup Assistant, 9–10
Share buttons, xx
Share pop-up menu, 29
Share Sheets, 149–150
Shared folders, 126
Shared lists, 31
sharing

Bluetooth, 558
Calendar, 309–313
files, 418–421, 423
files, multiple users, 126–127
Internet, 557
iTunes content, 208
printers, 343
Web pages, 460

Sharing & Permissions, Info window, 89
Sharing Only account, 562
Sharing pane (Internet & Wireless preferences 

panes), 553–558
shortcut keys, 18

TextEdit
font formatting, 183
text formatting, 184

Shortcut option (diction), 585
shortcuts

Expose, 255
keyboards. See keyboard shortcuts

Show all filename extensions option (Advanced 
Finder preferences), 467

Show Columns option, 480
Show Dashboard as a space option (Mission 

Control preferences pane), 507
Show fast user switching menu option (Users & 

Groups preferences pane), 569
Show Format Bar button, 439
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Spring-loaded folders and windows option (New 
Finder windows), 466

SSDs (sold state drives), 104
stack folders, customizing display, 470
Stack option (Display as option), 470
Stacks, 249

desktop management, 250–252
Standard account, 562
Start up automatically after power failure option 

(Energy Saver preferences pane), 524
Startup Disk pane (System preferences 

panes), 592
startup disks, selecting, 592
status bars, 23

Finder, 33
status checks (networks), 397
Stickies, 134, 247
sticky menus, 16
Stocks, 247
storage

devices, 103–104
burning CDs & DVDs, 109–112
disconnecting hard disk, 108
mounting disks, 105–106
unmounting & ejecting optical disk, 108
unmounting hard disk, 107

iCloud, xxi, 114, 265
disabling, 280
enabling iWork apps, 276
Find My Mac, 277–278
managing storage, 279
setting up, 266–268
using with iWork, 273–276
website interface, 269–272

submenus, 15
SuperDrives, 109
SuperDuper website, 114
Swipe between full-screen apps (More Gestures 

button), 531
Swipe between pages option (More Gestures 

button), 531
System folders, 38
System Information, 388
System Preferences, 134, 488–492

customizing, 492
locking/unlocking, 491
opening, 489
panes, 488–491
quitting, 490

sleeping computer, 35–36
sleeping displays, 524
slider controls, 167
Slideshows module (screen savers), 499
Slightly dim the display while on batter power 

option (Energy Saver preferences 
pane), 524

smart folders, 44, 99–101
smart groups

contact cards, 293
contacts, 293

smart playlists, iTunes, 205
Smart Quotes option (Language & Text 

preferences pane), 504
snapshots, Photo Booth, 230–232
Snow Leopard, updating, 5
Software Update, xxii, 8
software update options, 583–584
Software Update pane (System preferences 

panes), 583–584
sold state drives (SSDs), 104
songs, adding from audio CD, 200
Sort By icon view option (icon view window), 478
Sort By option, 480

column view option, 481
desktop view options, 482

Sort By pop-up menu, 173
sorting, 63

contact cards, 289
orders, notifications, 518

sound effects, 541
sound volume, 540
source lists, browsing iTunes, 202
Spaces, 249

desktop management, 257–259
Speakable Items option (Accessibility 

preferences pane), 591
special effects, Photo Booth, 231
spell check, TextEdit, 189–191
Spelling and Grammar window, 191
Spelling option (Language & Text preferences 

pane), 504
Spotlight comments

entering, 90
Info window, 89

Spotlight menu, 94–95
Spotlight pane (Personal Preferences), 494, 

514–516
spreadsheets, 131
spring-loaded folders, 78–79
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formatting text, 182
applying formatting, 184
fonts, 183

grammar check, 189–191
indentations, 185
inserting text, 180
launching, 178
opening documents, 196
pasting text, 187–188
quitting, 178
redoing actions, 186
replacing text, 181
saving documents, 194–195
selecting, 181
spell check, 189–191
tab stops, 184–185
undoing actions, 186

TextEdit icon, 19
Thank You window, 10
The Unofficial Apple Weblog website, 74
Three Finger Drag option, 532
thumb drives, 104
Tile Game, 247
time

limiting user time on computers, 576
options, 582
setting, 579–581
setting in Language & Text preferences 

pane, 505
Time Capsule, 398

creating networks, 399–401
Time Limits control (parental control), 571
Time Machine, xxiii, 134

backups, 115–117
restoring from, 120

Time Machine pane (System preferences panes), 
588–589

time zone, setting, 581
title bars, 23
toolbars, 23

Finder, 29–30
Finder window, 483–484

Traceroute screen (Network Utility), 425
Tracking option (Mouse preferences pane), 530
Tracking Speed option, 532
Trackpad pane (Hardware Preferences), 519, 

532–533
trackpads, buttons, 14
Transfer Information to This Mac window, 9
Translation, 248

System preferences panes, 488, 560–592
Accessibility, 590–591
Date & Time, 579–582
Diction & Speech, 585–587
Parental Controls, 571–578
Software Update, 583–584
Startup Disk, 592
Time Machine, 588–589
Users & Groups, 560–570

T
Tap to Click option, 532
Target Disk Mode feature, 592
TCP/IP, 428
TCP/IP option (Network preferences pane), 549
terabytes, 104
Terminal, 389
Terms and Conditions window, 10
text

commands, 192
TextEdit

applying formatting, 184
copying text, 187–188
cutting text, 187–188
deleting text, 181
entering text, 179
font formatting, 184
inserting, 180
opening documents, 196
pasting text, 187–188
redoing actions, 186
replacing, 181
saving documents, 194–195
selecting, 181
tab stops, 184–185
undoing actions, 186

text chats, 448
Text Only option (Show pop-up menu), 484
Text size option, 480

desktop view options, 482
icon view window, 478

text substitution options (Language & Text 
preferences pane), 504

text to speech options (diction), 586–587
TextEdit, xxiii, 134, 177

copying text, 187–188
cutting text, 187–188
deleting text, 181
dictation, 192–193
entering text, 179
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settings, 565
adding, 562–563
groups, help advice, 74
names, 415

Users & Groups pane (System preferences 
panes), 560–570

Users & Groups preference pane, 123
Users & Groups preferences pane, 415
Users folder, 38
utility applications, 131, 373

Activity Monitor, 374–375
automation tools, 392
Boot Camp Assistant, 374–375
ColorSync Utility, 377–379
Console, 380
DigitalColor Meter, 381
Grab, 382–383
Grapher, 384
Keychain Access, 385–386
Migration Assistant, 387
System Information, 388
Terminal, 389

V
vCards

creating, 287–288
importing, 287–288

Versions, 144
videos

chat, 449–450
DVD Player, 215–216
Photo Booth, 230–232

View buttons, 29
View menu commands, 30

active window only, 53
Clean Up, 54
Show Toolbar, 53

Viewer window, DVD Player, 215
views

full-screen, 142–143
options, setting, 476–482

VIPs, xxiii
Voice option (text to speech), 586
voice options, 586–587
VoiceOver, 10, 390–391

settings, 587
VoiceOver option (Accessibility preferences 

pane), 590
volume

icons, 19
sound, 540

Trash, file management, 48–50
trash icons, 19
troubleshooting, help advice, 74
Try to limit access to adult websites 

automatically option (Parent Controls 
preferences pane), 574

Turn Bluetooth Off command (Status menu), 412
Turn off text smoothing for font sizes option 

(General preferences pane), 495
Turn off when computer is not used for option 

(Keyboard preferences pane), 527
turning off. See also quitting

FaceTime, 455
tweets, Notification Center, 261
Twitter, xxi
two-button mouse, 14

U
Undo command (Edit menu), 92
uninstalling

font, 330
Launchpad, 141

Unit Converter, 248
unlocking System Preferences, 491
unsaved documents, 163
updates

apps, 176
options (software), 583–584
OS X Mountain Lion, 5
security, xxii
Snow Leopard, 5

URLs, viewing, 457
USB Apple Mouse, 13
Use all F1, F2, etc. keys as standard function keys 

option (Keyboard preferences pane), 526
Use iCloud for Find My Mac window, 10
Use LCD font smoothing when available option 

(General preferences pane), 495
Use relative dates option, 480
Use VoiceOver in the login window option  

(Users & Groups preferences pane), 570
users, 415

access, limiting with parental controls, 573
accounts

adding users, 562–563
deleting, 568
disabling parental controls, 572
enabling parental controls, 572
login items, 567
pictures, 566
setting up, 560
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widgets, Dashboard, 133, 239
browser, xxiii
browser display, 241
closing, 240
managing, 244–245
opening, 240
OS X overview, 246–248
utilizing, 242–243

Window menu commands, 165
windows

Buddies, displaying, 447
content

outline list view, 56
sorting, 55

Finder, 12, 23–28
customizing, 476–486
sidebars, 485–486
toolbar, 483–484
view options, 476–482

Finder Preferences, 464
views, 51–52

activating, 53
arranging contents, 63–66
column view, 59–60
Cover Flow, 61–62
Icon view, 54
iTunes, 203
list view, 55–58

WINS option (Network preferences pane), 549
Word Break option (Language & Text preferences 

pane), 504
word processors, 131
World Clock, 248
Write Only privileges, 416

Y
Your account name option (New Finder 

windows), 465

Z
zoom button, 23
Zoom option (Accessibility preferences 

pane), 590
zooming, windows, 27

W
Wake for Wi-Fi network access option (Energy 

Saver preferences pane), 524
Weather, 248
Web access, limiting access with parental 

controls, 574
Web Clip, 248
Web control (parental control), 571
Web pages

saving, 459
sharing, 460

websites
Apple, xx
Apple Support, 74
Carbon Copy Cloner, 114
Dropbox, 114
iCloud interface, 269–272
limiting access with parental controls, 574
MacFixit, 74
Maria’s Guides, xix
OS X Hints, 74
Peachpit, xx
SuperDuper, 114
The Unofficial Apple Weblog, 74

Weekday time limits option, 576
Weekend option, 576
Weekend time limits option, 576
When other devices browse option (Sharing 

preferences pane), 558
When receiving items option (Sharing preferences 

pane), 558
When scrolling option (General preferences 

pane), 494
When switching to an application, switch to... 

option (Mission Control preferences 
pane), 507

White option (Background of icon view 
window), 479

Whois screen (Network Utility), 425
Wi-Fi, 396, 406–407

connecting to networks, 407
connections, 548–549
hotspots, 428, 432

Wi-Fi option (Network preferences pane), 549
Wi-Fi Status menu, 405–406
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